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A\ Important note about USB Drives shipped with your system: Do not lose your RIP dongle! This is your
license key and if lost or damaged, a cost for replacement will be incurred. UNINET suggests that you
limit the physical handling of RIP dongles and use powered external USB hubs (as an example).

May 2024 Edition — A newer version of this manual may be available at www.icolorprint.com/support
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IColor™ 800W Model Summary

The IColor™ 800W printer has been developed to produce high-quality, conventional color prints with the out-of-
the-box functionality of printing in white. Now you can print on media up to 12.6” x 49.6” with IColor™ Technology.

Please follow the enclosed quick setup guide, as well as this manual, to get started. The IColor™ 800W comes
complete with 4 toner cartridges for full color + white printing (CMYW), including our exclusive fluorescent white
cartridge. Print a white overprint (in one pass) in concert with the IColor™ ProRIP software. Black is produced using
composite black (made from CMY), and features the blackest composite black in the industry.

Please note that vector and line art images, including text, are likely to produce the best results. For exciting design
ideas and suggestions for using the IColor™ 800W for maximum effect, please visit our website at
www.icolorprint.com.

IColor™ Standard 550/800 2 Step media has been optimized to provide quality results when used with the printer,
enabling the user to produce eye-catching designs which may be applied to a variety of textiles and surfaces.

Unpacking and installing consumables

Optimal Humidity Level:
45% - 65%
10 ik o

Optimal Temperature Range:

50°F /10°C - 75°F / 24°C L <S8 s en
(296" / e
Operation outside of these recommend (23.27) ?251??3';

parameters may lead to poor results.

/\ Take note of the install location, temperature and humidity settings which are suggested for optimal
printing conditions.

/\ The use of a dedicated circuit of at least 15 amps is required to avoid potential fusing issues.

/\ Power consumption (max): 12 amps (120v models) or 8 amps (230v models)
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Remove orange tape and packing material as indicated.

icolorprint.com 4 UNINET ICoLor



Close paper tray and open the main toner compartment.

13

Remove the rest of the orange tape, set the lock and unpack the toner cartridges.

16 18]

A
$

Gently shake each toner cartridge back and forth 7 or 8 times to loosen the toner that may be settled in the
cartridge due to shipping. Unscrew the toner lock and insert each cartridge into the corresponding section with the
arrow on top.
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AT

Close the main toner compartment. Connect either the network or USB cable depending on how you wish to operate

the printer.

I\ Never insert both at the same time, use either network or USB only.

/0

Plug in the power cord and power on the printer. The use of a dedicated circuit of at least 15 amps is required to

avoid potential fusing issues.

WARNINGS

/\ Your IColor™ 800W printer has been preconfigured from the factory for optimal performance. UNINET
strongly advises that you do not change any settings on the printer itself (through the control panel), unless
specifically directed by a certified UNINET technician. Otherwise, poor or inconsistent results could arise.

A\ Avoid setting custom administrator passwords or changing security settings on the printer control panel, as
hardware changes cannot be overridden or changed by UNINET if the password is forgotten and could lead
to possible irrevocable, catastrophic modifications that may result in rendering your printer inoperable. This

is not covered by your warranty.

A\ Al print commands are dictated and transmitted solely by the IColor™ ProRIP software. Any required
updates or modification would occur in the software and not hardware. It is always best not make any
changes to preset data (hardware of software) unless specifically directed by a certified UNINET technician.

/\ To ensure trouble free operation of the IColor™ ProRIP software, please uninstall any third party virus scan
software before proceeding. Virus scan software often views RIP software as an invasive program and
invariably deletes important files which can cause issues in the quality of the print or the overall operation of
the software. Windows Defender is the only known virus scan software which does not conflict with the RIP.
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Loading Media

e |If using tray 1, open the paper tray and load media with the print side face up

e Ensure the media locks in underneath the guides before closing the cassette.

e Ensure the paper stack does not exceed the upper limit mark inside the paper tray.

A\ Excess stacking can cause paper jams.

e Be sure to load more than a few sheets in this tray, or multiple sheet feeding may occur.

e Straighten curled or warped media before loading.

e Various sizes of media can be loaded - simply adjust the positions of the side fences and end fence to
match. Once loaded, carefully push the paper tray fully in.

o If using the bypass tray (suggested for transfer media), load the media face down until you hear a beep and
align the media guides to match the media size.
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Loading Banner Media (optional feature)

A itis possible to feed banner media manually. However, it is recommend to purchase the optional banner
media tray for higher volume printing.

e To open the banner media tray, turn the lock knob clockwise until its triangle mark stops at the unlock mark.
Be careful that your hand does not hit the banner paper guide tray when turning the knob.

e If you cannot turn the knob, turn it while pushing the banner paper guide tray toward the machine.

e Hold the handle in one hand while supporting the back of the bypass tray with the other hand, and then
open the bypass tray slowly.

e Open the bypass tray until it is parallel to the floor. Raise the banner paper guide tray, and then insert it into
the bypass tray until it becomes stable.

e Load the paper face down until you hear the beep.

e Align the paper guides to the paper size. If the guides are not flush against the paper, images might be
skewed or paper misfeeds might occur.

e Open the subtray, and then raise the minor banner paper guide tray. Set the leading edge of the paper
according to the paper size.

e When using paper that has a horizontal width of 1,200 mm (47.3 inches), curl the paper so that its leading
edge touches the minor banner paper guide tray.
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e When using paper that has a horizontal width of 900 mm (35.5 inches), curl the paper so
that its leading edge touches the side of the machine.

e When using paper that has a horizontal width of 457.2 - 900 mm (18.00 - 35.5 inches), set the paper so that
its leading edge protrudes from the banner paper guide tray.

e When using paper that has a horizontal width of 148 - 457.2 mm (5.83 - 18.00 inches), set the paper as
loading paper into the bypass tray.

e You can load up to 10 sheets of paper that has a horizontal width of 457.2 — 1,260 mm (18.00 - 49.60 inches)
into the banner paper guide tray.

e When loading multiple sheets of paper into the banner paper guide tray, be sure to load them as individual
sheets and not in a stack.

Closing the Banner Media Tray

e Remove any paper that is loaded.

e Fold the subtray up.

e Slide the paper guides outward to the maximum width.
e Fold up the banner paper guide tray.

e Hold the handle in one hand while supporting the back of the bypass tray with the other hand, and then
close the bypass tray slowly.

e Turn the knob counter-clockwise until its triangle mark stops at the lock mark.
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Removing Jammed Media

e To prevent misfeeds, do not leave any torn scraps of paper inside the machine. If the error message remains
displayed even after you remove misfed paper, fully open the front cover, and then close it.

e When removing jammed paper, do not touch the parts with a label indicating ‘hot surface’.
e Do not remove the fusing unit. Doing so will result in loss of print quality.

e Toremove paper that has not been fed into the fixing section correctly, remove the jammed paper through
the underside of the fusing unit. If the jammed paper cannot be removed through the underside of the fusing
unit, remove it from the top.

e If you are using the banner paper guide tray attached to the bypass tray, the paper loaded in the bypass tray
may fall out when you remove jammed paper. First remove the paper loaded in the bypass tray, and then
open the right cover.

e If a misfeed occurs, remove the jammed paper by following the procedures indicated in the animation that
appears on the screen and the sticker or sheet inside the front cover.

e The misfeed inside the machine will correspond to the letter in the graphic below, displayed on the control
panel.

I--l. I—
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IColor™ ProRIP Software Introduction

UNINET

ICOLOY ProRIP

Production Workflow Software

Use the IColor™ ProRIP software to print white as an overprint in one pass. This professional version is designed for
higher volume printing with an all new interface. Design files can be printed directly from your favorite graphics
program, as well as imported directly into IColor™ ProRIP.

The IColor™ ProRIP software allows the user to control the spot white channel feature, as well as spot color
overprinting, where white is needed as a top color for textiles. No need to create additional graphics with different
color configurations — the software does it all - and in one pass. Enhance the brilliance of any graphic with white
behind color.

Print and Transfer onto: Create unique items - The possibilities are endless!
Natural and synthetic fabric (Light and Dark) T-shirts and sweatshirts
Mugs and ceramics Aprons

Light, dark and clear labels Corporate logo shirts
Leather Mouse pads

Light and dark paper stock Sports apparel

Glass Jackets

Acrylic Tote bags

Wood Tattoos

Metal And much more!
Window Cling

Banners

And much more!

The most important point of the IColor™ ProRIP software is that it allows colors to be put down in layers. Regular
printer drivers only concern themselves with what the eye sees on the top layer, the RIP allows you to separately
control each layer, thus giving you the ability to control not only what you see, but what is behind that top layer
(typically the white layen).
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Print white as an overprint in one pass for reverse printing (typically used for transfer printing of textile and hard
surfaces), where white is needed as an overprint, applied on top of all the other colors. When the image is pressed to
the garment, the transfer sheet is flipped over and the white becomes the underprint. This is especially important
where images have half tones and 100% transfer of the image can be problematic, or when there is white in the
image that needs to show through on dark colored garments.

White toner performs the following functions:
1) To produce the color white on a dark garment.

2) To fill in the halftones on lighter images so that there is enough toner on the page to fully transfer to your
garment or to pull all the B adhesive.

/\ This second point is the most important one and the reason why you cannot simply use a CMYK printer for
transfer printing. Also, this is why you MUST use the color white all the time (assuming your image has some
halftones in it). Even when printing on a white garment and there is no white at all in your artwork. This is the
biggest misconception with new users.

/\ Don't make that mistake, always use the white toner cartridge for any type of transfer printing!
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IColor™ ProRIP Software Installation

Make sure all other programs are closed and virus software is uninstalled.
/\ Failure to uninstall virus software can lead to problems with installation and/or use of software.

A\ if you keep the virus scan software active after installation, you must add the ProRIP to the ‘safe programs’
list or issues with ProRIP software can result. Windows Defender is the only program which, to date, has not
affected the functionality of the ProRIP.

Plug in the included dongle into a free USB port on your PC. This dongle contains all of the software, manuals and

documents for your printer and software and also serves as your license key.

The use of a dedicated printer driver is not provided, nor is it necessary. The ProRIP software contains the driver
for this machine, and all printing should be done directly from the ProRIP software.

You have the choice of using the following connections: USB or Wired Network

For front panel internet access, Wifi is standard and should not be confused with printing via wifi. It is not
necessary if running the printer via wired network.

NOTE: It is suggested to copy all of the installation files located on the USB drive to a folder on your computer for
safe keeping and ease of installation.

/\ The IColor™ ProRIP dongle must be installed at all times when installing or running the program.

1 Navigate to the RIP setup folder on the ProRIP dongle or on your PC if you've copied these files. Right click
on the setup application file and ‘Run as administrator’.

2) Select the language for installation and click ‘OK’.

Kun as administrator

Troubleshoot compatibility

Move to Dropbox

¥
Ea Scan with Windows Defender...

Restore previous versions

Pygl  Select the language for the installation from the choices below. el >
Cut
Copy

Create shortcut
Delete

Rename
Properties

English ~
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3) You will be prompted to insert the USB dongle before proceeding with the installation. If already inserted,
click ‘Next’. (There is only one dongle shipped with your system, and can look like either of the types
represented below).

USB Flash Dongle pt

Caonnectyaour dongle PRIOR ta installing wour softwarel Windows will automatically detectthe dewvice, and
wiou can then click Nest to continue.

5]
T
ol
L
T
1

< Back Cancel

IMPORTANT: This USB dongle is your license key. Ensure that it is not lost or broken, as UNINET
cannot replace it without a charge. You cannot use the software without it installed in your PC.

4) Select either the 32 bit or 64 bit application (dependent upon your version of windows). Accept the terms of
the license agreement and click ‘Next’.

iColor ProRIP Setup
License Agreement

32-bit or 64-bit &

UniNet

N e t Copyright @ 2017 by UniNet Imaging, Inc.
n I UniNet Imaging, Inc.
_— 3232 West El Segundo Blvd
iColor ProRIP iColor ProRIP

Hawthorne, CA 90250
(631) 590-1040
PRODUCTION WORKFLOW SOFTWARE s PRODUCTION WORKFLOW SOFTWARE.

END USER LICENSE AGREEMENT

This End-User License Agreement (this "EULA”) is a legal agreement between you
(Licensee”) and UniNet Imaging, Inc. (Licensor”), the author of UniNet iColor ProRIP,
induding all HTML files, XML files, Java files, graphics files, animation files, data files,
technology, development tools, scripts and programs, both in object code and source code
(the "Software”), the deliverables provided pursuant to this EULA, which may indude
associated media, printed materials, and "online” or electronic documentation.

By installing, copying, or otherwise using the Software, Licensee agrees to be bound by
the terms and conditions set forth in this EULA. If Licensee does not agree to the terms
and conditions set forth in this EULA, then Licensee may not download, install, or use the
Software.
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5) Choose ‘Full install of IColor™ ProRIP’ and click ‘Next’. Click ‘Next’ again to accept the installation folder.

iColor ProRIP Setup x iColor ProRIP Setup x

Choose Destination Location

UniNet UniNet

iColor ProRIP . igngjﬂqmmﬁlm?

WORKFLOAY SOFTWIARE.

6) Click ‘Next’ to allow the creating of the IColor™ ProRIP Program Folder and the installation will begin.

iColor ProRIP Setup

Select Program Folder
Pl

UniNet

Color ProRIP

UniNet

(Color ProRIP

~
Accessories
Administrative Tools
APEX2Print
Backup and Sync from Google
Best Software, Inc
v CHROMiX
. Corel VideoStudio X3
CorelDRAW Graphics Suite X8 (64-bit)
Dropbox
EDGE2Print.
Games
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7) If not already installed, you will be prompted to install NET Framework, which is a necessary component to
the ProRIP software. Accept the license terms and click ‘Install’. Once the InstallShield Wizard is complete,
click ‘Finish’.

/\ This installation normally takes several minutes to complete.

o Microsoft NET 2015 - X
.NET Framework 4.6.2 Setup
Please accept the license terms to continue. .NET

U i U i N e t InstaliShield Wizard Complete

n MICROSOFT SOFTWARE SUPPLEMENTAL LICENSE TERMS 2 n The Instalsh

——— e Instals

iCDIDI‘k P .NET FRAMEWORK AND ASSOCIATED LANGUAGE PACKS FOR iColor‘ PFORIP
PRODUCTION WORKF| MICROSOFT WINDOWS OPERATING SYSTEM PRODUCTION WORKFLOW SOFTWARE.

Microsoft Corporation (or based on where you live, one of its
affiliates) licenses this supplement to you. If you are licensed to use
Microsoft Windows operating system software (the "software”), you
may use this supplement. You may not use it if you do nothavea

[A1 have read and accept the license terms. = W
Download size estimate: oMB
Download time estimates: Dial-Up: 0 minutes

Broadband: 0 minutes

For data collection information, read the Microsoft Privacy Statement.

ProRIP First Time Setup

1 Be sure the IColor™ ProRIP dongle is installed and you are connected to the internet.

e From the Windows Start menu, choose All Programs >> IColor™ ProRIP or double click on the
desktop icon that was created upon installation. Launch the program.

e Create a shortcut if desired for quicker access later.
e Confirm first time setup by setting your preferred unit of measure and decimal places. This can be
changed later under Tools >> Options.

First Time Setup

You are running iColor ProRIP for the first time. Please review initial settings and modify to
suit your preferences.

B Color ProRIP

Where applicable, all numeric values will be displayed using the selected units and number of

LT decimal places set below.
E iColor ProRIP
Set display units; | inches i

> iColor ProRIP HE||_',| File Set number of dedmal places: 2

Hen1ute SUF."PEII'T n To change these settings, and for advanced options, click on Tools->Options..." after

the application begins.

Update iColor ProRIP

JEEE»
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2) Once the ProRIP opens, the Queue Wizard will begin the installation of the support files for your IColor™
printer. Click ‘Next’ and then ‘Install Printer’.

Create Queue Wizard Create Queue Wizard
th'uiu:ﬁm (Printer Defaults
Welcome to the production queue setup wizard, Assign a default printer for this production queue.

Select the default printer, print mode, and output port for this queue:

This wizard will set up your local production queue. A production queue manages your

print and cut jobs for your configured printers and cutters. Printer:
Port: FILE -
Print mode: w

To continue, dick 'Mext', or dick 'Cancel' to quit.

e —
Back il Cancel Back Cancel
e ——

3) Select the appropriate printer from the support menu (in this case, choose the IColor™ 800W). Click ‘OK’.
Then click ‘Next’ to continue the installation.

Lreate Liueue VW

C Install Printer X ' Add Printer
Select a printer from the list you want iColor ProRIP v2 Dealer to support ]
Device Package Search
Search:‘ | | Clear

(®) search for new printer package(s) from DVD or Cloud server,

UniNetiColor 500 v2
Search Cloud server for printer package(s).

UniNetiColor 540 v2 Internet access required for this search to take place
UniNetiColar 550 v2
UniNebiCalox &0 v2 []search ovD.

Please insert Printer DVD supplied with Rip Software

UniNetiColor 800W
(C) Don't search automatically, I will choose the search location

Select this option if you would like o select a printer package from a specific location, This
printer package may not be the most recent version available,

Browse...

4 Back Cancel L

cnce S N
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4) Click the ‘Port Setup’ dropdown and select how your printer is connect (Network or USB).

A\ You must complete this step or you will not be able to print.

5) If connected via network (recommended), choose TCP/IP. If connected by USB, choose the printer as

identified in the drop down.

I\ For USB connections, do not choose the port ‘Printer_USB-001+". The proper port will also have the

printer name in the description.

A\ Al other ports will update automatically, it is only necessary to do this for one queue.

Add Printer

9l

(Cnpyi ng Device Packages

Overall copy progress
Installing UNIB0OW.1.0.RQ.pkg64 for printer UniMet iColor 800W

Download progress
UNIB0OW.1.0.RQ.pkg64 From updater.cadlink.com

Downloaded:  6.37 MB copied in 0 seconds

Transfer rate:  86.43 MB/Sec

Extraction progress
Extraction Complete

Next

Back Next Cancel

Add Printer

(Prinl:er Port Setup

You have Queue(s) installed for the printer UniNet iColor 800W.

Fort Setup:

Printer_USB-001+
FILE
MNULL

6) If connected via network, once TCP/IP is selected, the software will poll your network for available printers.
Select the proper IColor™ printer. Note that the IP address of the printer is displayed.

/\ Be sure to set a static IP address for your printer so that the IP address does not change later. If this

happens, you will have to repeat this step.
Port Settings X
Properties for port: TCP/IP (Network Device)

TCP Printers  Remote Printing  Timeouts

Uninet iColor 800W ( 192.168.112.42 )

Searching:

[ o ]

icolorprint.com

Cancel

18

Add Printer

Il

(Cnnﬁgurah’on Summary

You have completed the Install Device Wizard.

Uniliet iColor 800W

Driver package [Version 1.0]: Installed successfully

D
K Finish ), R

Back Next Cancel
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7) If you need to change or reset the ports in the future:

Click Queue >> Manage Queues to view, update or change the port settings.

A\ Port settings will reset when the queues are updated so you will have to do this from time to time.

Jobs Devic®gTools View Help
QLR endH e
= v i ¥
L I R R end
i St
Unil fop
Clear Job Errors 00 05 10 L5 20 25 30 35 40 45 50
Nar Set maximum white ink... Copies
Setup black removal...
Setup how much white to use under black...
Set white choke...
Setup color boost...
Setup photo merge...
Properties... Alt+Q
<
i
»
< > Queue ‘ UniMet 2 Step Standard v ‘
~ —— . —
Name Status PrintMode Copies A Size:[827inx 11690 || e
Layout: Auto Page v ..
Input Tray | ByPass Tray ~
[ a.o0in D & 0.00in ]  Ouput Resolution | 600x600 v
E 0.00 m: @ 0.00 m: Paper Type | Thick to 30g ~
< >

8) In the ‘Port’ drop down menu, choose the proper port. If connected via network (recommended), choose
TCP/IP. If connected by USB, choose the printer as identified in the drop down. All other ports will update

automatically, it is only necessary to do this for one queue.

.
_ = Queue Manager

= X

+= X W

Queue Printer Control Panel Group Enabled

UniNet iColor800W | .. | dsbh | UniNetiColor800w v || .. | fTCPP (Network Device) (192.. V) .. | [ Install ] [ o]l

< >
L

icolorprint.com 19 UNINET IGOLOr




9) If connected via network, once TCP/IP is selected, the software will poll your network for available printers.
o Select the proper IColor™ printer. Note that the IP address of the printer is displayed.

e Be sure to set a static IP address for your printer so that the IP address does not change later. If this
happens, you will have to repeat this step.

Setting a static IP:

On the LCD screen of the printer, click User Tools>>Machine Features>>System Settings>>Interface
Settings>>Machine IPv4 Address. Click ‘Specify’, then you can manually add your desired IP address. Once
complete, click OK and exit.

/\ Do not alter any other settings on the printer itself!

@

. EREmC |
Srecify » 58 1 ‘TWRS!E]@

i i - 192. 168, 112. 157 et
— J* 0 |#
55 75550 — — 158

10) To begin, select the media type and the size you wish to use under the queue tab at the bottom right of the
screen. The input tray and paper type will be automatically set based on the media selected. UNINET
suggests that you do not alter these settings.

File Queue Jobs Devices Tools View Help

oo GH#BD EH=TH YO GHE =EHE

PRl ——— %%
0 1 2 3 4 5 6 7 8 9
Name Status PrintMode Copies [ S I S A R
5
5
n
e
[s]
N
=
i
)
2
.-
=
-
5
&
e
=
5
q
9
P —
< > {Eﬁ_  uniniet 2 Step standard Y |
ik e, - ——— ~
Nome p— PrrtMode Copies Tabloid XL Jumbo Giee n250imx1200m P [
Layout ‘-_W |
Input Tray | ByPass Tray ~
ool 0.00in D & 0.00in S OuputResolution | 600x600 v
I 0.00in - T 0.00in PaperType | Thickto0g
< >
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1D Import the desired graphic by clicking the ‘green plus’ icon and navigating to the proper folder.
e You can also import by clicking File > Import File, or simply dragging and dropping your file into the queue.

File Queue Jobs Devices Tocls View Help

DR o GeB HEH=218 GO GKE B8 O

| Unitet sCobos S00W [1]

@

totak 1 0 1 2 3 4 5 6 7 8 9 0 11 12 13 14 15 16 17 1
Nariv Status Bt Made Copins chadatebbeiv bbbl b ebbebe bbbl gt g
Carnival_FColor_Latter,
% Camival_iColor_Lett.  Pending UniMet2 Step Standard .t
¥
.
| "
e — i A
| :
- h
- - y i
L =
e ERSN
o e .
|
« 2| | D ooe (D
e e T emmemeeee] -
served - 2 ;
Tablosd XL Jumbs Size: [1250inx 1900 v |
Name Status Print Mode Copies p ittt . - ol
Layout Aulo Page | .
2 15 Ingut Tray | ByPass Tray
H 0.00in I ga0in o OutputRescluen | S00:E00
o a00in ] 0.00in PaporT)'pel Thick 10 90g
Hest Page et All
< >

12) There are preloaded images that can be used to print a test page.

o Click Devices >> Print Test Page to see the choices. It is suggested that you print a test page upon
completion of the setup to confirm the printer has been properly installed. Use [Shift] and [Ctrl] to
click multiple pages), and then click OK.

e More about the uses of each page can be found in the Help Topics file within the ProRIP program as
well as the ProRIP User Manual.

= iColor ProRIP: UnilNet iColor 550 Overprint Print Test Page X
File Cueue Jobs Devices Tools View | Items selected (0.0f 11) Seiect Al Sel
Manage Devices... - WEPS  Ca_01iColor 1117 2
Manage Print Modes... 7980 comva Cor Leter

PRSI )
Manage Print Media... ﬁ DD o 01 1ol pa

8L Buteries iColor_8_5X17
Manage Spot Colors..,

Cream White shirt

H My Art Black shirt
E Rusty truck Black shirt

Flowers Color shirt

Manage Device Spots ...
Spot Plane Mapping...

Printer Properties...

Print Test Page...

List item size: I

<

[Juse current selection for 'Quick Print Test!

| =
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Using the ProRIP Software (Summary)

Once your image is loaded, take note
of the preconfigured settings
relating to the media being used in
the printer.

The ‘Queue’ tab shows the size of
the media that will be used, where to
load the media into the printer and
the paper type setting
recommended.

Each media type will contain this
preconfigured data to make your
printing experience as easy as
possible. Overriding these settings
could yield undesirable results.

To alter the color settings, click
on ‘Color Adjust’ and adjust as
needed. ‘Coverage %’ represents
the amount of white/clear toner
overprint or underprint
(depending on which queue is
being used).

The ‘Vary hole size in areas of
transparency’ option allows for
rasterization of colors that fade
into nothing and to retain partial
transparency. It is suggested
that this option is left on, as it
will only apply itself where it’s
needed.

‘Choke’ dictates how much the
overprint white layer is pulled in
under the colors. The higher the
number, to more it’s pulled in (to
avoid a white outline around
your graphic).

icolorprint.com

Queue | Page Job Unilet 2 Step Standard R4
A
Tabloid XL Jumbo Size:[1250inx19.00in]
Layout Auto Page
Input Tray | ByPass Tray w
H 0.00 in C I 0.00 in : Output Resolution | 600x600 v
el 0.00in 0 T 0.000n o Paper Type | Thickto 90g -
Color Adjust
Y Easy Color Adjustments pod
Layers Color Layer v
Lighter 0 Darker
Lighter = 0 Darker
Lighter 0 Darker
-
Manx Ink 400
Brightness 0
Saturation 0
@) |CC Setting ) Photo () Graphics
Holes
Enable Ink Removal
Hole Size 180
No Ink 100% Ink
Vary hole size in aregl of partial transparency
Transparency Hole Size 0.70
Bigger holes, Smaller holes,
Less ink Mare ink
OK | | Cancel
L
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The ‘Page’ tab offers the W

ability to print multiple 'Sheet 1 - Tabloid XL Jumbo [ Carnival_iColor_Letter.pdf ] v|
copies and nest images. Tabloid %L Jumbao Size:[1250inx19.00in]  ~
You can also adjust the size Layout Auto Page v | |
of the image to fit your media 1o Input Tray | ByPass Tray
here (and in the Queue tab). |+>[ 0.00in ; 0.00in .  OutputResolution | 600x600 ~
e 0.00in o TF 0.00 in o Paper Type | Thick to 90g “
The ‘Job’ tab allows you to ‘ Hest Page H Nest All
lock the proportions of your
image to maintain the aspect b |Unm 2 Step Standard - |
ratio.
‘ Copies... ‘ ‘ Crop... | | Duplicate... |
Here you can also mirror, Carnival_iColor_Letter pdf
rotate and invert the image, = 8.50in _, @l [1] 11.001n o 100.00 % C| Rotate: None
as well as adjust the margins { — ﬁ —

of the print if necessary.

Note that the mirror function ‘ Color Adjust ‘
is automatically on for any ‘
image loaded into the
overprint queue.

Invert H Mirror

e You can also adjust the size of any image by dragging and dropping the corner of the image in the preview
pane.

e In this example, where we have a letter sized image placed on an A4 artboard, the red bar to the right of the
image represents the portion of image that is outside the print margins. Be sure to resize to eliminate this
bar before printing.

Carnival_iCelor_Latter. pdf

Camival_iColor_Letter paf

| Camival_iColor_Leaer pdl

Camival_iolor_Leger pot

= wan s (@ [T ey [ 150625 O Rotle Menw - L+ e E ‘:;:: E : I‘U - :';7 w0l e |Fome tore |
'l soons 5 omml Bl S
CARNIVAL Caor sy
Color At N ma [ e
L (e —
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Adjustments can also be made by using these icons at the top of the screen.

2 RED & D

When ready, click the ‘Print’ icon to print your graphic.

File Queue Jobs Devices Tools View Help

2L IGRDARCSDIE YOI b

I. Uinilye ol 800V (1]
otal. 1 :
Mamne Status. Pant Mode Copies it 15t trbpirt i
B CommvaliColor_Lua Pendng Uit 2 Stiep Standlind
<3 -
e [ e ALY A
| i R
I~
< > pov
- Sheet 1 - Tablowd XL umbo [ Carnival_iColor_Letter.pdf ] -
Resenod b i i e
Mame Status Print Moda e | Tabloid XL Jumbo See (1250 % 1900im]
Layout AuoPage
Iﬁ: 1% Input Tray | ByPass Tray o
[ 0.00in o 000m . OutputRescluticn | E0E00 v
e o00in 0.000n Paper Type | Thickta 90g =
| st Page st Al
< >

I\ if you encounter any of these issues when printing from the RIP, please refer page 19, step 7 to
set the proper port in Queue Manager.

e Port Failed to open

e Holding

e  Prompt to save rather than print

e Unknown Error
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File Queue Jobs Devices Tools View Help

e

o

i Linibiat iCalor B0OW |

MName

Once the print has completed, the job will be archived in the
reserved area for 7 days. If you wish to reprint that job, drag and
drop the job from the reserved section into the queue.

<

Ruserved

Do GiegD BE=1H Y&

Status Frnt Mode Copues

>

May it FPrnt Mode Copus
igi Camival_iCologen  Waiting Liniet 2 Step Standard

To lengthen the amount of time a job stays in reserve, click Queue>>Properties. Then click ‘Job Reserve’ and set the

‘Auto Clean Reserve’ time frame. Unclick to keep jobs in reserve forever.

FiIJobs Devices Tools View Help

Manage Queues...

Start
Stop

Clear Job Errors

Set maximurn white ink...

Setup black removal...

Setup how much white to use under black...
Set white choke...

Setup color boost...

Setup photo merge,..

icolorprint.com

® Settings

General

Hot Falders
Media Setup
Layout Manager
Printer Status
Job Reserve

(%) Layer HH
® Cther

Alt+Q

25

Job Reserve

[#Enable job reserve

After a job has completed output, it will be placed in the bottom reserve bin for
output at a later time. The job will retain the same output and layout settings used
during the original output.

[15ave Spool file on job reserve

Saving spoal files will alow faster reprinting of jobs, however spool files can
consume a lot of disk space. If you are running out of hard drive space you might
consider having spoal files deleted after job reserve.

Auto Clean Reserve

Storage Statistics

2.73MB Total process queue storage size
0.00 KB Total active spool file size
0.00 KB Total reserved spoal file size

Delete reserved spoal files
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After a particular job has printed, it will be ‘closed’. This means that it was rendered by the software so that the next
time you print, the processing time will be minimal. If you need to make any changes to the print job before printing,
you must ‘open’ the job. Otherwise, just reprint as needed (processing time is faster when already rendered).

File Queue Jobs Devices Tools View Help

oo GREB HHM=TH GO K &

I TEETERENOON

total: 1) pending: 1

Name Status

% Carnival_iColor_Lett.. Pending

<

Print Mode

UniMet 2 Step Standard

Copies

Reserved

Name Status

Print Mode

Copies

% %

| Print H

Carnival_iColor_Letter.pdf

13

For more detailed instructions for the IColor™ ProRIP software, please consult the IColor™ ProRIP User Manual.

Visit www.icolorprint.com/support for the most updated written and video instructions on the IColor™ ProRIP

software.

icolorprint.com
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Achieving the darkest black color

To obtain the darkest black print on your IColor™ 800W and IColor Transfer Paper (except IColor Select Paper), set
the color of the black portions of your artwork to 100% C, 100% M, 80 — 85% Y. It may be necessary to do this from
the RIP, as some file formats may convert differently than others once imported.

For IColor Select 2 Step Transfer Paper, set the color of the black portions of your artwork to 90% C, 90% M, 80 Y.

1 Load your image into the IColor™ ProRIP as you normally would.

2) Click the ‘Job Color Replacement’ icon at the top of the screen. =

il

3) Use the dropper to select the portion of the graphic you wish to
modify.
e Inthis case, the black artwork was imported with the wrong color codes as indicated by the input color fields

and requires modification.

4) Enter the correct color code for black in the output fields and click the

To select an input color, click on the image.
Cyan  Magenta Yellow White
input [965[] 97.6[8] 957 00

tput | 00 oo™ oo™l oo

a b

Measure| 0.0 004 0.0;%' Convert|

Tolerance: 5
‘White / Clear Opacity: 70

Color Replacements

Load [ save Apply

&+r icon, then CIiCk tapplyr. To select an input color, click on the image,

Cyan Magenta Yellow White

5) Your artwork now has the correct color code and will print the darkest nput | 9658 9768 9572 00™=]
black color Output | 1000 % 1000 %] 80.0[2] 00

L a b
Measure| |00 0.0 8] | 0.0 ¥ [Convert

Tolerance: 5

‘White / Clear Opacity: 70

Color Replacements

Load Save

Cyan Magenta Yellow White
Input
Qutput % [

Cyan Magenta Yellow White
Input

Output % [=
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UNINET

ICOLOY SmartCUT

Oversize Image Transfer Solution

Why use IColor™ SmartCUT?

SmartCUT allows owners of smaller width printers to gain the benefits of tabloid or larger sized printers.

SmartCUT is a user centric tool that is a key component to expanding the size constraints of popular print methods,
especially as it relates to transfer printing commonly associated with garment decoration. This ground breaking
application turns your letter / A4 sized printer into a tabloid ‘plus’ capable machine, allowing for the splitting and
splicing of one graphic across two or more printed transfer sheets without seeing the seam!

Use any oversized graphic along with a transparent transfer sheet, and the software will split it in half along the most
logical path. You can choose to have it split along dark or light areas, depending on the color garment you will be
pressing onto. With this software, you can make large designs that are not possible with even the most expensive of
printing systems because you can split up your graphic onto as many transfer sheets as you want.

SmartCUT can be used in tandem with any RIP software package and printer. It was designed from the ground up
with ease of use as a paramount consideration. Most functions are automated to allow you to focus on finding the
best starting point to split each job. Final results can be used on virtually any printer. White toner printers highly
recommended.

SmartCUT supports many file types such as PNG, JPG, BMP, GIF and TIFF files.

The program works as an integral part of a decorating system, where the split pages are printed onto IColor™
Standard or Select transparent transfer media. The sheets are then lined up visually on the substrate through the
transparent sheet.

Print and press onto plus size garments such as 2X, 3X, 4X. The ability to print designs that properly fill out these
large sizes creates the opportunity for high value garments that can fetch a premium price. A very high percentage
of designs used are virtually imperceptible by even those who know that a seam exists.

SmartCUT is more than just ‘splitting software’ - it's a RIP enhancement tool!

New features include:

e The ‘Selective Masking Tool allows you to point and click to rasterize or distress elements of your design
based on color or shape.

e [Color™ ProRIP software integration for ease of use.

e The ‘Real Preview’ tool which applies the white adhesive behind the image (digitally) and then applies the
image it to the color and texture of a shirt. The result is a much more realistic preview of how your image will
look once pressed.
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Use Genuine UNINET IColor™ Consumables

Use only genuine UNINET IColor™ consumables. The use of incompatible supplies (toner, drum, transfer belts, fusers
and registration assemblies) may cause damage to your printer not covered by your warranty. Contact your dealer
to reorder supplies.

A Always replace toner and drum cartridges in the specified slot according to color or serious damage
could result.

Replacing toner and drum cartridges

Supplies Replacement Guide

Printer Display Reads: Replace:
Cyan low/out/empty Cyan
Magenta low/out/empty Magenta = o]
Yellow low/out/empty White @ . . ® S N
Black low/out/empty Yellow 8 o @E
o= — [} )
wl) Clo T() ey . @
| K=)| o

Be sure to follow the guide above. Do not rely on what the printer control panel displays!

The IColor™ 800W is not capable of White underprint® applications and cannot accommodate specialty
cartridges such as Dye Sublimation, Fluorescent, Clear, Gold and Silver toner cartridges.
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Cleaning the Dustproof Glass

If white lines appear on prints, clean the dustproof glass.

1. Turn the printer off and unplug the power cable.

2. Holding the left and right handles, open the front cover.

3. Remove the cleaning stick installed inside the front cover by pushing and holding the grip in the center (1)
and then lifting the handle of the cleaning stick (2).

4. Insert and remove the cleaning stick at least three times in each of the 4 holes.
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5. When finished, place the cleaning stick back inside the front cover.

Color Registration Procedure

If the printer registration is out of alignment, run the Color Registration Procedure

e Signs of this would appear as outlines of white or color around your graphic.

1. Using the touch screen on the printer, press User Tools on the home screen.

2. Select Maintenance > Image > Color Registration.

3. Press Start to execute the auto Color registration (This take about 30 seconds).

4. After ‘Color Registration is complete’ appears, press ‘Exit’
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Printing Tips

When transferring images with halftones, it’s possible that some of the adhesive from your 2 step paper will not
transfer over to the toner during the first step. If you see this happen with your image, just reprint the image with a
white overprint using the ProRIP to thicken up the density and give the adhesive something to stick to. Halftone
colors use much less toner. Printing the white over the image will fill in the halftones of color, with density below
70%. Using white overprint is necessary, even when transferring to white colored textiles.

There are many variables that could produce different results. Specific steps may need to be altered based on:

e Type and brand of Heat Press: The temperature and duration varies slightly based on the heat press being
used. All instructions are based on using a Hotronix Fusion press. Clam shell and other types of swing away
presses may also yield different results.

e Type of image: Photos or full color graphics may require a longer press time than vector images or text.

e Type of garment or substrate: Cotton, Polyester, and Spandex material all respond differently to heat, as do
hard surfaces like acrylic or wood. All textile instructions are based on cotton garments.

e Toner Coverage: Halftones in image may cause undesired results. Toner coverage should not be less than
70%, otherwise there will be issues with transferring the adhesive to the transfer sheet. Halftones can be
corrected by printing white on top of color using the IColor™ ProRIP Software to apply a white layer in one
pass. This will help with toner coverage and proper adherence to the garment.

Consult the IColor™ knowledge base for specific instructions on a variety of transfer paper offered at:
http://www.icolorprint.com/support

(Or scan this QR Code)

6]

Technical Support Email: Log a ticket at https://www.icolorprint.com/get-support

Technical Support Phone: 631-590-1040, Option 2

SAVE THE BOX AND PACKAGING! Needed if the machine needs to be sent back for service.
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ALSO AVAILABLE:

e |Color™ Premium 2 Step Transfer Paper for light and dark colored garments

e |Color™ Select and Select Ultra Bright 2 Step Transfer Paper for light and dark colored garments

e |Color™ Standard 2 Step Transfer Paper for light and dark colored garments

e |Color™ Glitter Adhesive 2 Step Transfer Paper (for use with IColor™ Standard 2 Step Transfer Paper)

e |Color™ Light 1-Step Transfer Paper for light colored garments

e |Color™ Presto 2 Step Transfer Paper for textiles and hard surfaces
e IColor™ Temporary Tattoo 2 Step and Easy Tattoo Transfer Paper

e |Color™ Classic, Premium, Wood and Leather and Ceramic Hard Surface 1-Step Transfer Paper

e |Color™ AquaClear 1-Step Transfer Paper for candles and other substrates not resistant to heat
e |Color™ Label / Sticker Paper (Clear and White) in Letter and Tabloid size
e |Color™ Window Cling Media (Clear and White) in Banner and cut sheet options

e |Color™ Banner Paper

e |Color™ Magnetic Media in Letter and Tabloid size

...and more! Contact your dealer for more information.

IColor™ Transfer Paper Comparison Charts

ICOLOR TEXTILE TRANSFER PAPER

ATTRIBUTE PREMIUM ‘ PREMIUM STRETCH' STANDARD | SELECT UB | SELECT PRESTO LIGHT SPEEDTRANS LIGHT
PROCESS 2 Step 2 Step 2 Step 2 Step 2 Step 25tep 15tep 15tep
DURABILTY (# of Washes @ 104 °F/40 °C) Up to 100 Up to 100 50+ 50+ 50+ 50+ 15+ 1B+
DARK TEXTILES (BRILLANCE) BEST BEST BETTER BEST GOOD BETTER FAIR FAIR
DELICATE TEXTILES BEST BEST GOOD GOOD GOOD GOOD NOT RECOMMENDED | NOT RECOMMEMDED
STRETCHABILITY BETTER BEST GOOD BEST BEST GooD GOoD GOOoD
FINISH MATTE MATTE SEMI GLOSS MATTE MATTE SEMI CLOSS SATIN SATIN
TRANSFER 'A' SHEET CHARACTERISTIC OPAQUE OPAQUE TRANSPARENT TRANSPARENT ™ TRANSPARENT OPAQUE OPAQUE OPAQUE
PRESS TEMPERATURE (*F/°C) 250°F /120°C 285°F /140°C 310°F /154°C J10°F /154°C J10°F / 154°C 285°F /140°C 390°F / 200°C 375°F /190°C
PRESS TIME 30 + 30 secs 45 +10 secs 120 + 30 secs 120 + 25 secs 120 + 25 secs 120 + 30 secs 16 secs 10 secs
SOFT HAND BEST BEST GooD GOOD GOOD GOCD BETTER BETTER
COsT $5% $5% $$ $$ §% $$ $ $
* Select BOO Ultra Bright has an opaque ‘A’ sheet
ICOLOR HARD SURFACE TRANSFER PAPER
ATTRIBUTE PREMIUM CLASSIC [ CERAMICS | WOOD/LEATHER | PRESTO! HARD SURFACE | PRESTO! PAPER/WOOD | AQUACLEAR | TATTOO
PROCESS 15tep 15tep 15tep 15tep 15tep 15tep 15tep 2 5tep
DURABILTY (RESISTANT TO SCRATCHING/CHIPPING BEST BEST BEST BEST BEST BEST GOOD BETTER
COLOR BRILLIANCE BETTER BETTER BETTER BETTER BEST BEST BETTER BETTER
METALLIC FINISH N MO NO NO YES YES NO MO
PRESS TEMPERATURE ("F/*C} 300°F / 150°C * 300°F /150°C * 300°F [150°C B00°F /160°C * 320°F J160°C " 265°F / 130°C " N/A 265°F /130°C
PRESS TIME 60 SECS * B0 SECS * 180 SECS * 60 SECS 180 SECS * 90 SECS * MN/A 40 SECS
ACRYLIC YES YES YES YES YES NO YES YES
METAL YES YES NO NO YES NO YES YES
CERAMIC YES YES YES ND YES NO YES YES
TILE YES YES YES NO YES NO YES YES
GLASS YES YES YES YES YES NO YES YES
CRYSTAL YES YES YES YES YES NO YES YES
PAPER/WOOD/CARDBOARD YES YES NO YES YES YES NO YES
LEATHER YES YES NO YES NO NG NO YES
CANDLES NG NO NO NO NO NO YES YES
FLESH NO NO NO NO NO NO NO YES
[cosT 5 s s s S s S 558

* Temporature and pross time varics based on substrate
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IColor™ 800W System Specifications

Print Speed: Print Speed: Up to 45 ppm Color and Monochrome
(Transfer media setting speeds may vary)

Processor: Intel 1.75 GHz
Duty Cycle: Up to 75,000 pg/mo.
Memory: 2GB RAM
Resolution: Up to 1200 x 1200 dpi
Emulation: PCL® 6, PCL 5c; PostScript® 3™
Operating Systems: Microsoft Windows® 8 /10 / 11 (x32 & x64)
Interfaces: 10/100-TX Ethernet, High Speed USB v2.0, Wifi through front access panel (not for printing)
Multipurpose Tray: Standard 100-sheet; handles transfer media, card, mailing label stock and banners
Paper Cassette: 2x 550-sheet Legal/Letter/Universal
Paper Sizes (Min./Max.): Multipurpose tray handles up to 100 sheets — 3" x 5” to 12.6” x 49.6”;
e Tray 1Paper Cassette - Fixed for Letter (8.5" x 11") (216 x 279 mm), A4, A

e Tray 2 Paper Cassette - User adjustable up to 12" x 18" including Letter (8.5" x 11"), Legal (8.5" x 14"), Exec
(10.5" x 7.25"), Ledger (11" x 17", A3, A4, A5, A6 Custom Sizes: 3.55" x 5.83" - 12.6" x 18" / SRA3 (90 x 148 mm

to 320 x 457 mm)

Paper Weight: Standard Trays: 16 - 82 Ib. Bond/ 170 Ib. Index (60 - 300 g/m2)
Bypass Tray: 14 — 82 Ib. Bond/ 170 Ib. Index (62 — 300 g/m2)
Size: (WxDxH): 23.1" x 27" x 34" (587 x 685 x 864 mm) (Standard Configuration)
Toner Cartridge Yield: All rated at 5% toner coverage

e Standard CMY: 35,000 pages

e Standard White: 25,000 pages

e Starter CMY: 12,500 pages

e Starter White: 10,000 pages
Weight: 187 Ib. (85 kg)
Power Consumption (maximum): 12 amps (120v models) or 8 amps (230v models)

Power Options: 120v & 230v models
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